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About this Guide
Welcome to the HP SOA Systinet Plug-In Guide. This guide explains how to use Systinet Plug-In with
SOA Systinet.

This guide contains the following chapters and appendices:

• Chapter 1, Systinet Plug-In

• Chapter 2, Getting Started

• Chapter 3, Exploring the Repository

• Chapter 4, Generating Service Clients

• Chapter 5, Generating Service Skeletons

• Chapter 6, Validating Resources

• Appendix A, Dialog Boxes

• Appendix B, Configuring Systinet Plug-In

5



Document Conventions
This document uses the following typographical conventions:

Script name or other executable command plus mandatory arguments.run.bat make

Command-line option.[--help]

Choice of arguments.either | or

Command-line argument that should be replaced with an actual value.replace_value

Choice between two command-line arguments where one or the other is
mandatory.

{arg1 | arg2}

User input.java -jar hpsystinet.jar

File names, directory names, paths, and package names.C:\System.ini

Program source code.a.append(b);

Inline Java class name.server.Version

Inline Java method name.getVersion()

Combination of keystrokes.Shift+N

Label, word, or phrase in a GUI window, often clickable.Service View

Button in a user interface.OK

Menu option.New→Service
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Documentation Updates
This guide's title page contains the following identifying information:

• Software version number, which indicates the software version

• Document release date, which changes each time the document is updated

• Software release date, which indicates the release date of this version of the software

To check for recent updates, or to verify that you are using the most recent edition of a document, go to:

http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign-in. To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html

Or click the New users - please register link on the HP Passport logon page.

You will also receive updated or new editions if you subscribe to the appropriate product support service.
For details, contact your HP sales representative.
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Support
You can visit the HP Software Support Web site at:

http://www.hp.com/go/hpsoftwaresupport

HP Software Support Online provides customer self-solve capabilities. It provides a fast and efficient way
to access interactive technical support tools needed to manage your business. As a valued support customer,
you can benefit by using the HP Software Support web site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a
support contract.

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html
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1 Systinet Plug-In

SOA Systinet enables your organization to manage the growth and development of your service infrastructure.
HP SOA Systinet Plug-In bridges the gap between your development environment and SOA Systinet.

This chapter introduces Systinet Plug-In in the following sections:

• Overview on page 9

• Usecases on page 10

Overview
HP SOA Systinet Plug-In is a set of features enabling you to integrate SOA Systinet with your IDE.

Systinet Plug-In contains the following features:

• Search

Search the SOA Systinet repository to find the service definitions you require.

For details, see Chapter 3, Exploring the Repository.

• Generate

Generate service clients and skeletons from repository resources.

For details, see Chapter 4, Generating Service Clients and Chapter 5, Generating Service Skeletons.

• Validate

Validate resources in your IDE against policies in the SOA Systinet repository.

For details, see Chapter 6, Validating Resources.
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Usecases
Systinet Plug-In is designed to assist in the development of services for the following users:

• Service Architects

Validate WSDLs before publication.

Using policies imported from SOA Systinet, validate your service definitions to ensure they meet your
policy requirements.

For details, see Chapter 6, Validating Resources.

• Service Consumers

• Locate the services you want to consume.

Repository Search enables you to identify services you want to consume. You can limit the search
to services that are consumable, or to a particular lifecycle stage (for example, Production).

For details, see Searching the Repository on page 19.

• Generate service clients for services you want to consume.

Using the service definitions located in the search, generate a service client from the service definition
to assist the development of your consuming service.

For details, see Chapter 4, Generating Service Clients.

• Service Providers

• Locate the service definitions you want to develop.

Repository Search enables you to identify services you want to develop. You can limit the search
to services at particular lifecycle stages (for example, Initial or Development).

For details, see Searching the Repository on page 19.

• Generate service skeletons for services you want to develop.
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Using the service definitions located in the search, generate a service skeleton from the service
definition to assist the development of your service.

For details, see Chapter 5, Generating Service Skeletons.

• Validate your local resources against policies from the SOA Systinet repository.

Using policies imported from SOA Systinet, validate your resources to ensure they meet your policy
requirements.

For details, see Chapter 6, Validating Resources.
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2 Getting Started

Systinet Plug-In works in conjunction with your existing development platform.

This chapter contains the following sections:

• Installing Systinet Plug-In on page 13

• Setting the Server on page 16

Installing Systinet Plug-In
HP SOA Systinet Plug-In is a plug-in for Eclipse distributed as an archive file, hp-soa-systinet-plugin-
eclipse-3.02-updates.zip.

For supported platforms and known issues, see readme.txt alongside the archive.

Systinet Plug-In has dependencies on the following plug-ins:

• DTP SDK 1.5

http://www.eclipse.org/datatools/downloads.php

• EMF SDO Runtime 2.3.0

http://www.eclipse.org/modeling/emf/downloads/

• GEF Runtime 3.3

http://archive.eclipse.org/tools/gef/downloads/drops/R-3.3-200706281000/index.php
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• WTP 2.0

http://www.eclipse.org/webtools/releases/2.0/

• XSD Runtime 2.3

http://www.eclipse.org/modeling/mdt/downloads/?project=xsd

Install these plug-ins before installing Systinet Plug-In.

To install Systinet Plug-In to Eclipse:

1 In your current Eclipse SDK (3.3 or later), use the software updates feature to install Systinet Plug-In.

Select Help→Software Updates→Find and Install....

The Install/Update dialog opens.

2 In the Install/Update dialog, select Search for new features to install, and click Next.

The Install – Update Sites to Visit dialog opens.

3 In the Update Sites to Visit dialog, click New Archived Site.

The Select Local Archive Site dialog opens.

4 Locate and select hp-soa-systinet-plugin-eclipse-3.02-updates.zip, and then click Open.

The Edit Local Site dialog opens.

5 In the Edit Local Site dialog, if required, rename the local archive name, and click OK.

6 In the Install – Update Sites to Visit dialog, select the new local archive, and then click Finish.

The Updates – Search Results dialog opens.

7 Select the archive, or expand the archive and select individual components, and click Next.
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Systinet Plug-In consists of the following components:

• Search and Validate

The search and validation features of Systinet Plug-In.

• WTP Integration

The integration points with the WTP plug-in.

The Install – Feature License dialog opens.

8 In the Feature License dialog, select I accept the terms in the license agreements, and click Next.

The Install – Installation dialog opens.

9 In the Installation dialog, if required, change the installation location, and then click Finish.

To start Systinet Plug-In:

• Execute ECLIPSE_HOME/eclipse.exe.

The first time you start Systinet Plug-In, you are prompted for the connection URL and credentials for the
SOA Systinet server.

Do one of the following:

• Set a connection URL and credentials and optionally select to save them, and then click OK.

The SOA Systinet server must be running.

• Click Skip to set them later. For details, see Setting the Server on page 16.
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Systinet Plug-In uses the Eclipse API to store passwords. Saved passwords are stored in a file that
is difficult but not impossible for an intruder to read.

Setting the Server
The develop services in conjunction with SOA Systinet you must set the credentials for the server you are
working with.

To set the SOA Systinet server:

1 From the menu, select Window→Preferences.

The Preferences dialog box opens.

2 In the tree view of the Preferences dialog box, select HP SOA Systinet.

The HP SOA Systinet page opens, as shown in Figure 1.

Figure 1. HP SOA Systinet Page
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3 Set the connection details for the SOA Systinet server. Optionally, save these credentials or use Validate
to test the connection.

4 Click OK.
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3 Exploring the Repository

Systinet Plug-In enables you to search and examine data in the SOA Systinet repository.

These features are described in the following sections:

• Searching the Repository on page 19

Locate specific artifacts using lifecycle, consumption, and property criteria.

• Search Results on page 20

View artifacts matching your search criteria and their related artifacts.

• Artifact Detail View on page 21

Examine individual artifacts in detail.

Searching the Repository
HP SOA Systinet Plug-In includes a Repository Search feature, enabling you to explore the content of SOA
Systinet.

To search the repository:

1 Do one of the following:

• From the menu, select Search→Repository.

• Use the keyboard shortcut, Ctrl+R.

The Search dialog opens displaying the Repository Search tab.

2 In the Scope section, select an artifact type to search, and if required, a specific lifecycle stage.
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The Properties section refreshes showing specific details depending on the artifact type.

Generating service clients and skeletons uses WSDL definitions to create code stubs. To find
the WSDL you need, search for SOAP Services or Operations, as these artifacts contain
lifecycle and contract information. The functionality for generating code stubs is available
on search results for SOAP Services and Operations and utilises the WSDLs associated with
them.

3 Enter your search parameters. The parameters vary depending on the artifact type.

For parameter details, see Repository Search on page 46.

4 To display the parent artifacts search result artifacts depend on, select Show Parent Artifacts

5 Click Search to execute the search.

Systinet Plug-In displays the results of the search in the Repository Search Result tab. For details, see
Search Results on page 20.

Search Results
Systinet Plug-In displays the results of a repository search in the Repository Search Results tab.

To search the repository, see Searching the Repository on page 19.

The results show a tree of artifacts for each artifact matching the search criteria, as shown in Figure 2:

Figure 2. Repository Search Results View
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The tree for each matching artifact contains any related child artifacts. If you select Show Parent Artifacts
in your search, the tree also includes related parent artifacts.

Double-click an artifact name in the Repository Search Results tab to view its details in an artifact details
tab. The tab name is the name of the artifact. For details, see Artifact Detail View on page 21.

For SOAP Services and Operation artifacts, the search results provide code generation functionality. Right-
click the resource and select Generate Service Client or Generate Service Skeleton. For details, see
Chapter 4, Generating Service Clients or Chapter 5, Generating Service Skeletons.

The hierarchy of artifact types and the properties displayed for each artifact type are defined in
the configuration you can customize.

For details, see Appendix B, Configuring Systinet Plug-In.

Artifact Detail View
Systinet Plug-In enables you to view the details for a particular artifact in its own detail view. The content
of this view is similar to the Artifact Detail View in the Tools tab in SOA Systinet.

In Eclipse, this kind of view is normally called an Editor. However, Systinet Plug-In does not
provide editing features in these Artifact Views.

The artifact details vary depending on the artifact type and your customization and configuration.

For details about customizing the detail views, see Appendix B, Configuring Systinet Plug-In.

The Artifact Detail view contains the following segments depending on the artifact type:

• General

Displays a description, the owner of the artifact, and a URL to the XML representation of the artifact.

• Details

Displays a set of properties for the artifact. These properties vary depending on the artifact type.
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• Data

Displays a link to the attached data in the repository for artifacts with attached data content. Click the
link to view the content of the attached data.

• Relationships

Displays the set of related artifacts, indicating the type of relationship, the related artifact, and the
direction of the relationship.

Double-click an artifact name to open its detail view.
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4 Generating Service Clients

Systinet Plug-In integrates with existing Eclipse Web Tools Platform (WTP) functionality, enabling you
to create a client stub from resources in the repository.

To generate a service client stub:

1 Perform a repository search to locate the resource you want to use for client generation.

For details, see Searching the Repository on page 19.

For consumer use cases search for Consumable services at the Production lifecycle stage.

2 In the Repository Search Results view, right-click the Operation or SOAP Service to use for client
generation, and select Generate Service Client.

Generating a client uses the WSDL associated with SOAP Service or Operation.

The Web Service Client dialog opens.
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3 Use the Web Service Client dialog to select your project and environment settings.

For details, see the WTP documentation at the following location:

http://help.eclipse.org/help33/topic/org.eclipse.jst.ws.axis.ui.doc.user/tasks/tsampappa.html

The WTP plug-in looks for a Dynamic Web Project and warns you if there is no such project
available. It is possible to ignore the warning and select a plain Java project instead.

Click Client Project and select the project you require.

The WTP plug-in uses the provided WSDL to generate source code stubs for the service client.

Use the Package Explorer to access the generated code.
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5 Generating Service Skeletons

Systinet Plug-In integrates with existing Eclipse Web Tools Platform (WTP) functionality, enabling you
to create a skeleton stub from resources in the repository.

To generate a service skeleton stub:

1 Perform a repository search to locate the resource you want to use for skeleton generation.

For details, see Searching the Repository on page 19.

For provider use cases search for services at early lifecycle stages, such as Initial or
Development.

2 In the Repository Search Results view, right-click the SOAP Service or Operation to use for client
generation, and select Generate Service Skeleton.

Generating a skeleton against a SOAP Service or Operation uses the WSDL associated with
it.

The Web Service dialog opens.
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3 Use the Web Service dialog to select your project and environment settings.

For details, see the WTP documentation at the following location:

http://help.eclipse.org/help33/topic/org.eclipse.jst.ws.axis.ui.doc.user/tasks/tsklwsdla.html

The WTP plug-in requires a Dynamic Web Project for skeleton generation.
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The WTP plug-in uses the provided WSDL to generate source code stubs for the service skeleton.

Use the Package Explorer to access the generated code.
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6 Validating Resources

Systinet Plug-In enables you to validate local resources against policies.

This chapter contains the following sections:

• Setting Up Validation on page 29

Explains the process of importing and updating policies from the Policy Manager.

• Ad Hoc Validation on page 33

Explains how to run unscheduled validation and produce reports.

• Automatic Validation on page 38

Explains how to set up automatic validation.

Setting Up Validation
Systinet Plug-In contains a default set of policies. You can add or delete policies, and update your local
policies against versions from an SOA Systinet server. Systinet Plug-In also includes the default HP SOA
Systinet Policy Manager extension, which contains default Policy Manager validation handlers.

Validation is introduced in the following sections:

• Setting Up Policies on page 30

• Importing Policies on page 31

• Removing Policies on page 32

• Updating Policies on page 32

• Customizing Validation Handlers on page 32
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Setting Up Policies

You can add, delete, or update policies in the Systinet Plug-In Policies page.

To set up policies:

1 From the menu, select Window→Preferences.

The Preferences dialog box opens.

2 In the tree view of the Preferences dialog box, expand HP SOA Systinet→Policy Validation→Policies.

The Policies page opens, as shown in Figure 3.

Figure 3. Policies Page
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In the Policies page, do any of the following:

• Import an archive or folder.

For details, see Importing Policies on page 31.

• Remove a policy

For details, see Removing Policies on page 32.

• Update local policies.

For details, see Updating Policies on page 32.

Importing Policies

You can import policies from an archive or folder from a designated HP SOA Systinet server.

To import an archive or folder from an HP SOA Systinet server:

1 In the Policies page, do one of the following:

• Click Import Archive to open the Select an Archive to Import dialog box, and then go to Step 2.

• Click Import Folder to open the Select a Folder to Import dialog box, and then go to Step 3.

2 Enter the required parameters and browse for the archive you need, and then click Open.

The selected archive is imported to the Policies page.

3 Browse for the folder you need, and then click OK.

The selected folder is imported to the Policies page.

The Import Archive and Import Folder buttons load policies, assertions, and remote server
information from the client distribution, created during the installation process in the folder SOA_HOME.
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The import of the client distribution will fail if the provided folder or archive does not follow the
structure of the SOA Systinet 3.00 client distribution, which must include the bin, conf, data,
extensions, and lib folders.

Removing Policies

To remove a policy:

• Highlight the policy in the Policies page, and then click Delete.

Updating Policies

You can use Systinet Plug-In to update local policies against policies on an SOA Systinet server.

To update policies:

1 Make sure the SOA Systinet server is running.

2 Click Update.

The local version of the policy is updated to reflect the version on the HP SOA Systinet server.

Customizing Validation Handlers

Systinet Plug-In includes a set of validation handlers, contained in the standard Policy Manager extension.
Custom validation handlers can be included in the Systinet Plug-In by adding the appropriate extensions.

To add extensions to Systinet Plug-In:

1 From the menu, select Window→Preferences.

The Preferences dialog box opens.

2 In the tree view of the Preferences dialog box, expand HP SOA Systinet→Policy Validation→PM
Extensions.

3 Click Add.
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The Select an Extension dialog box opens.

4 Browse for the .jar file you require, and then click Open.

The extension is now visible in the PM Extensions page.

You must restart Systinet Plug-In for your changes to take effect.

Ad Hoc Validation
Ad hoc validation is the unscheduled validation of documents against policies.

Ad hoc validation is described the following sections:

• Running Ad Hoc Validation on page 33

• Viewing Ad Hoc Validation Results on page 34

• Revalidating a Document on page 36

• Exporting Reports on page 37

• Setting Report Style on page 37

Running Ad Hoc Validation

To run ad hoc validation on a single resource:

1 Right-click a document in Project Explorer to open its context menu, and then scroll over Check Policy
Compliance.

A list of available policies is displayed.

2 Select the policy you want to validate the document against.

The validation runs and the result is shown in the Validation Result tab.

For details, see Viewing Ad Hoc Validation Results on page 34.
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To run ad hoc validation using multiple resources or policies:

1 Right-click a document in Project Explorer to open its context menu, and then scroll over Check Policy
Compliance.

A list of available policies is displayed.

2 Select More Validation Options.

The Edit Configuration and Launch dialog box opens, as shown in Edit Configuration and Launch on
page 42.

3 To add documents, do one of the following:

• Click Add File to browse and select documents from your Eclipse project.

• Click Add External File to browse and select documents from your file system.

• Click Add External Folder to browse and select all documents in a folder in your file system.

• Click Add URL to enter the endpoint URL of a remote document.

4 In the Technical Policies field, click Add to select from a list of available policies to use in the validation.

5 Click Run.

The validation runs and the result is shown in the Validation Result tab.

For details, see Viewing Ad Hoc Validation Results on page 34.

Viewing Ad Hoc Validation Results

When validation completes, the Validation Result view displays the results. For each result, you can view
a detailed HTML report. You can also view a summary report for all validation results.

The default report style is similar to that of Policy Manager validation reports. For information about setting
report styles, see Setting Report Style on page 37.
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To view a validation report:

• Right-click a validation result in the Validation Result tab to open its context menu, and then select 
View Detail.

An HTML report opens, as shown in Figure 4.

Figure 4. Validation Report

If you have more than one validation result, you can view a summary report of all the validation results.

To view a summary report, click the Summary Report button on the Validation Result tab.

The Summary Report view opens, as shown in Figure 5.
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Figure 5. Summary Report

To view the detailed report of a document in the summary, click the report hyper link in the Details column.

You can set a resource in the results view to be automatically validated. Right-click the resource to open
its context menu, and select Set as Automatic Validation. The resource is re-validated against the set of
automatic policies for the project and added to the custom list of project resources to be validated. For
details, see Setting Up Automatic Validation on page 38.

Revalidating a Document

If recent changes have been made to a document, you can revalidate that document.

To revalidate a document:

• Select a result in the Validation Result tab, and click Revalidate.

The document is revalidated against the selected policies.
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Exporting Reports

You can export the report to your file system.

To export a validation report:

• Select a result in the Validation Result tab, and then click Export Reports.

• Browse for the location to which you want to save the report, and click OK.

Both detail and summary reports are saved.

Setting Report Style

Included with Systinet Plug-In is the Policy Manager detail report stylesheet. If you want to change the
stylesheeet, you can select from a pure text style or XML format.

To change the style of ad hoc validation reports:

1 From the menu, select Window→Preferences.

The Preferences dialog box opens.

2 In the tree view of the Preferences dialog box, expand HP SOA Systinet→Policy Validation.

The Policy Validation page opens. For details, see Policy Validation on page 44.

3 In the Validation Result Format pane, select one of the following options:

• Text Format, then go to Step 5.

• XML Format, then go to Step 4.

4 In the Stylesheet pane, select one of the following options:

• Associate with default stylesheet.

• Custom stylesheet, then browse for the stylesheet you need.
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5 Click OK to produce the report in the selected format.

Automatic Validation
Systinet Plug-In enables the automatic validation of documents while you work on them.

After you set up automatic validation, you can see annotations to your document that change in real time.

Automatic validation is described in the following sections:

• Setting Up Automatic Validation on page 38

• Disabling Spell checker on page 41

• Assertion Details on page 41

Setting Up Automatic Validation

To enable automatic validation, you must set it up for a project.

To enable automatic validation:

1 Do one of the following:

• Right-click the project in Project Explorer to open its context menu, and select Configure Automatic
Validation→Set Project to be Automatically Validated.

• Right-click the project in Project Explorer to open its context menu, and select Properties.

In the tree menu, select Automatic Validation.

The Properties for [Project Name] dialog box opens showing thw Automatic Validation options. For
details, see Properties for [Project Name] on page 45.

2 Select Set Project to be Automatically Validated if it is not already set.

3 In the List of Policies pane, click Add and select the policies you need. Click OK.

4 In the List of Resources pane, select one of the following:
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Default (Entire Project), then go to Step 6.•

• Custom, then go to Step 5.

5 Select any of the following:

• Add

To add a folder from your project.

• Exclude

To exclude individual files from the selected folder.

• Remove

To remove the folder from the list.

6 In the Filtered By pane, do any of the following:

• Click Add to add a file extension.

• Click Remove to remove a file extension from the list.

7 Click OK to confirm automatic validation settings.

The validation runs and the results are displayed in the Automatic Validation Results view, as shown in
Figure 6.
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Figure 6. Automatic Validation Results

After automatic validation has been set up, you have the option to include or exclude documents for validation.

To include or exclude documents:

1 Right-click the document in Project Explorer to open its context menu.
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2 Select Configure Automatic Validation, and do one of the following:

• Select Exclude from Validation Path to remove the document from the validation process.

• Select Include in Validation Path to add the document to the validation process.

You can also add resources to the custom list from the Validation Results view. For details,
see Viewing Ad Hoc Validation Results on page 34.

Disabling Spell checker

In Eclipse 3.3 (or higher), the spell checker annotates documents that are open in the main view. The spell
checker annotations can obscure Systinet Plug-In automatic validation annotations. You should therefore
disable the Eclipse spell checker.

To disable the Eclipse spell checker:

1 From the menu, select Window→Preferences.

The Preferences dialog box opens.

2 In the tree menu, expand General→Editors→Text Editors→Spelling.

3 Deselect Enable spell checking and click OK.

Assertion Details

You can view additional details about assertions that were violated. Systinet Plug-In can create a special
tooltip describing the assertion, with HTML links to assertion description web pages.

To view an assertion description:

• Right-click one of the errors listed in the Problems view to open its context menu, and then click View
Assertion Description.

A tooltip opens with the assertion description and a link to available online resources about the assertion.
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A Dialog Boxes

Each Systinet Plug-In input dialog is described in the following sections:

• Edit Configuration and Launch on page 42 Run ad hoc validation on several documents and policies at
the same time.

• Policy Validation on page 44 Set preferences for your report style.

• Properties for [Project Name] on page 45 Set up automatic validation for your project.

Edit Configuration and Launch
Run ad hoc validation on several documents and policies at the same time:
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DefinitionParameter

The name you want to use for the validation check.Name

The list of resources you want to use for validation.Sources

Browse and select documents from your Eclipse project.Add Resource

Browse and select documents from your file system.Add External File

Browse and select all documents in a folder in your file system.Add External
Folder

Enter an endpoint URL of a remote document.Add URL

Remove previously selected documents.Remove

The list of technical policies associated with the resources.Technical Policies
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DefinitionParameter

Select from a list of available policies to use in the validation.Add

Remove previously selected policies.Remove

Filter available documents or policies by file type.Filtered By

Add a specific file type.Add

Remove a previously selected file type.Remove

Apply the current configuration.Apply

Restore the previous configuration.Revert

Start validation.Run

Close the dialog box without launching validation.Close

Policy Validation
Set preferences for your report style:
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DefinitionParameter

Choose whether you want the validation results to be in Text or XML format.Validation Result
Format

Choose whether to use the default or a custom stylesheet.Stylesheet

Browse for and select a custom stylesheet.Browse

Specify the maximum number of returned results.Validation Result
Limit

Filter available stylesheets by file type.Filtered By

Add a specific file type.Add

Remove a previously selected file type.Remove

Save your preferences.OK

Exit without saving your preferences.Cancel

Properties for [Project Name]
Set up automatic validation for your project.
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DefinitionParameter

Available policies for use in validation.List of Policies

Browse for and select the policies you need.Add

Remove previously selected policies.Remove

Choose whether you want to use resources in the entire project (default) or create a
custom selection.

List of Resources

Add custom resources.Add

Exclude specific files from the selected resource.Exclude

Remove previously selected resources.Remove

List of associated file types.Filtered By

Add a specific file type to the filter.Add

Remove a previously selected file type from the filter.Remove

Save your settings.OK

Exit without saving your settings.Cancel

Repository Search
The property parameters available in the Repository Search dialog vary depending on the artifact. The
artifacts available and their properties also vary according to your customization and configuration.

For details about customizing Systinet Plug-In, see Appendix B, Configuring Systinet Plug-In.

This section describes the default parameters for the default artifact types in the following sections:

• Repository Search: Application on page 47

• Repository Search: Business Service on page 47

• Repository Search: SOAP Service on page 48

• Repository Search: Operation on page 49
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Repository Search: Application

This section describes the default property search parameters for applications.

DescriptionProperties

Name of the application.Name

Description of the application.Description

Select to restrict the search to consumable applications.Consumable Only

Alias for the application.Alias

Version number.Version

Repository Search: Business Service

This section describes the default property search parameters for business services.
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DescriptionProperties

Name of the business service.Name

Description of the business service.Description

Select to restrict the search to consumable business services.Consumable Only

Version number.Version

Any keywords assigned to the business service.Keyword

Repository Search: SOAP Service

This section describes the default property search parameters for SOAP services.
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DescriptionProperties

Name of the SOAP service.Name

Description of the SOAP Service.Description

Select to restrict the search to consumable SOAP services.Consumable Only

Version number.Version

Service namespace defined in the associated WSDL.WSDL Service
Namespace

Repository Search: Operation

This section describes the default property search parameters for Operations.
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DescriptionProperties

Name of the operation.Name

Description of the operation.Description

XSD fault types defined for the operation.Fault Types

Select to restrict the search to consumable operations.Consumable Only

Operation name defined by the associated WSDL.Operation Name

XSD output types defined for the operation.Output Types

Set of related operations defined by the associated WSDL.Port Type

Namespace defined by the associated WSDL.Target Namespace

XSD input types defined for the operation.Input Types
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B Configuring Systinet Plug-In

Systinet Plug-In uses a configuration file at the following location in the SOA Systinet repository:

http://host:port/soa/platform/rest/location/hpsoa/client/search-configuration.xml

This file is a server specific configuration that all instances of Systinet Plug-In access to determine the
format and content of repository search for that server.

When you first use Systinet Plug-In in your organization you must upload this configuration to the SOA
Systinet server after you make any changes to reflect your requirements.

Systinet Plug-In contains a default configuration defined in the following file:

ECLIPSE_HOME/plugins/com.hp.systinet.tools.search.core_3.02.vBUILDTIME/config/default_config.xml

To change the Systinet Plug-In configuration and upload it to SOA Systinet:

1 Copy default_config.xml and rename the copy search-configuration.xml.

2 Open search-configuration.xml with a text editor.

3 Edit search-configuration.xml to reflect your requirements.

For details, see the following sections:

• Configuring Search and Detail Parameters on page 52

• Configuring Search Results on page 53

• Configuring Artifact Hierarchies on page 54

• Configuring Localization on page 55
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4 In SOA Systinet use the Upload Content feature to store the configuration in the repository.

In the Upload Content page, specify the following location:

/hpsoa/client

For details, see "Uploading Service Infrastructure from Definition Documents" in the HP SOA Systinet
User Guide.

Configuring Search and Detail Parameters
The artifact types in Repository Search and the property parameters displayed in Repository Search and the
Artifact Detail View are defined in the <details_view> section of the configuration file.

For example, the application artifact is defined as follows:

<details_view>
  <artifact_type localName="hpsoaApplicationArtifact">
    <invisible_properties>
      <property localName="lastRevision"/>
      <property localName="revision"/>
      <property localName="identifierBag"/>
      <property localName="artifactType"/>
      <property localName="categoryBag"/>              
      <property localName="stakeholderEmail"/>
      <property localName="criticality"/>
    </invisible_properties>
  </artifact_type>
  ...
</details_view>

To configure the Repository Search:

1 Open search-configuration.xml with a text editor.

2 Do any of the following:

• Add an artifact type to search by adding an <artifact_type> segment using the localName of the
artifact type.

• Remove properties from the search parameters and detail view by adding a <property> in the
<invisible_properties> segment of an artifact, using the localName of the property.
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You can locate the localNames in your configuration at the following location:

http://host:port/soa/systinet/platform/restBasic/repository/sdm/sdmConfig.xml

3 Save search-configuration.xml.

Configuring Search Results
The property parameters displayed for artifacts in the Repository Search Results view are defined in the
<search_result> section of the configuration file.

For example, the application artifact is defined as follows:

<search_result>
  <artifact_type localName="hpsoaApplicationArtifact">
    <visible_properties>
      <property localName="name"/>
      <property localName="version"/>
      <property localName="productionStage"/>
      <property localName="description"/>
    </visible_properties>
  </artifact_type>
  ...
</search_result>

To configure the Repository Search:

1 Open search-configuration.xml with a text editor.

2 Do any of the following:

• Add an artifact type to search results by adding an <artifact_type> segment using the localName
of the artifact type.

• Add properties to the results for an artifact type by adding a <property> in the <visible_properties>
segment of an artifact, using the localName of the property.
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You can locate the localNames in your configuration at the following location:

http://host:port/soa/systinet/platform/restBasic/repository/sdm/sdmConfig.xml

3 Save search-configuration.xml.

Configuring Artifact Hierarchies
Service artifacts in SOA Systinet form natural hierarchies. Repository Search locates the artifacts matching
your search criteria, and if requested, any related artifacts specified in the hierarchical structure defined in
the configuration.

For example, the default hierarchy is defined as follows:

<hierarchical>
  <artifact localName="hpsoaApplicationArtifact">
    <artifact localName="businessServiceArtifact" upRef="hpsoaProvidingApplication"
      downRef="hpsoaProvidesBusinessService">
      <artifact localName="webServiceArtifact" upRef="inBusinessService" downRef="service">
        <artifact localName="wsdlArtifact" upRef="definitionOf" downRef="definition"/>
      </artifact>
    </artifact>
  </artifact>
</hierarchical>

You can add and modify hierarchies to match those relevant to your requirements.

To configure the Repository Search hierarchies:

1 Open search-configuration.xml with a text editor.

2 Do any of the following:

• Add a hierarchy by adding the top level <artifact> within the <hierarchical> segment, defined by
its local name.

• Add artifacts to hierarchies by adding <artifact> within a nested structure of an artifact hierarchy.
Define the artifact with a local name and directional relationship properties.
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You can locate the localNames and property names in your configuration at the following
location:

http://host:port/soa/systinet/platform/restBasic/repository/sdm/sdmConfig.xml

3 Save search-configuration.xml.

If you define multiple hierarchies, the first hierarchy defined takes precedence in the event of a
conflict.

Configuring Localization
Localized text can be configured in repository search for artifact names in the <artifact_mapping> section of
the configuration file.

For example, the application artifact is defined as follows in English, Spanish, and Vietnamese:

<artifact_mapping>  
  <artifact_type localName="hpsoaApplicationArtifact">
    <custom_name value="Application"/>
    <custom_name locale="es" value="Aplicacion"/>                
    <custom_name locale="vi" value="&#7912;ng D&#7909;ng"/>                
  </artifact_type>
  ...
</artifact_mapping>

To configure the localized text in Repository Search:

1 Open search-configuration.xml with a text editor.

2 Add a new mapping rule for localization to Repository Search by adding an <artifact_type> segment
using the localName of the artifact type.

Specify the text to be localized with a <custom_name> specifying the text to be localized when the artifact
type is rendered.
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Add location specific text for an artifact type by adding a <custom_name> to the artifact specifying the
locale and the text to use in that location.

You can locate the localNames in your configuration at the following location:

http://host:port/soa/systinet/platform/restBasic/repository/sdm/sdmConfig.xml

3 Save search-configuration.xml.
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